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1.0 INTRODUCTION 
 

650 Interface Module 

 

The 650 module acts as a digital indicator unit and is capable of addressing all channels in 

the system and displaying their data in volts. 

 

The 650 module also provides a simple yet flexible interface between the analogue signals 

of the various 600 series amplifier modules, and a computer with a suitable RS232 port. 

The 650 module assumes that the analogue signals are calibrated as 0 to 10V or ±10V 

over the range of the transducer, although it is possible to use it with lower outputs. 

 

The configuration of the 650 involves telling the 650 a scaling factor (plus some other 

information) in order that it can calculate the digitised output in engineering units (e.g., mm, 

lbs, psi etc.) 

 

The data from the 650 unit can be transferred in a number of ways. 

 

1) The data from a single channel may be requested by the host computer, in which 

case the 650 will sample, then send the data for the requested channel. 

2) The data from all enabled channels may be requested by the host computer in which 

case the 650 will sample all enabled channels in turn and send heir data in a single 

delimited string. 

3) The 650 may be programmed to send the data from all enabled channels at various 

times, intervals or upon specified transducer levels being reached. 

4) The 650 may be programmed as above, except that the data may be stored in the 

internal memory of the 650 for downloading to the computer at a later date. 

 

Data logging rates vary considerably with different baud rates, however, if data is logged to 

internal memory, sample rates of up to 100 scans of all enabled channels may be 

achieved. Therefore for higher speed logging, logging to memory is best. However, if it is 

essential to see the data in 'real time' then the manual contains information on calculating 

serial transmission rates. 

 

651 expansion Module 

 

The 651 is only present in systems that have more than 1 rack in the same case. If your 

system is housed in a 602, 603 or 604 housing, the 651 will not be present so you may 

ignore the remainder of this paragraph and any references to the 651. If your system is in a 

605 housing or higher and has a 650, each rack except the one with the 650 in should have 

a 651 fitted. The 651(s) provide an interface between the 650 and other racks in a system. 

It does not require any user configuration, as it will have been factory set. 

 

1.1 BEFORE POWERING-UP CHECK... 

 

1 The supply voltage is correct to suit the 631/632 unit fitted and input range selected 

2 The various plug-in modules are in the correct positions in the housing. 

3 The input and output plugs are in the correct sockets.  Note that on the housing 

back-plane all input sockets and all output sockets are of the same type. 
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4 Before connecting a transducer, ensure that the correct excitation voltage has been 

set.  Too high a voltage can destroy a transducer 

5 That each module has a unique address. (see section 3.12) 

1.2 Information on Conformity to EC Directives. 

 

This module is not CE marked because it is intended for use as a component of a larger 

system. RDP CE mark full modular 600 systems that includes a 60X housing and a 63X 

power supply where the system is fully populated with either 600 series amplifier/display 

modules or blank panels. 

 

If the module is part of a full 600 system, refer to the system manual (CD2010) for CE 

certification. 

 

If the module is not part of the full 600 system, it is the responsibility of the organization/ 

individual producing the system to assess and/or test EMC compatibility. 

 

2.0 USING THE 650 AS A DIGITAL INDICATOR 
 

Refer to Fig.1 for front panel layout. 

 

2.1 650 Controls 

 

During data logging operations the 650 display 

ceases to display channel data. The display 

during data logging is detailed in later sections. 

 

When the 650 is not logging data, the 650 will 

monitor the selected input signal and all the 

control push-buttons can be used to change the 

selected input signal (see below for further 

information).  Otherwise the  and  can be 

used to control data acquisition (see section 7.0 

for further  information). 

 

The control push-buttons are as follows: 

 

Control Description 

INPUT Displays the selected input signal. 

CHAN Displays the selected module. The module is selected by the address set on 

the address switch of the input amplifier, not necessarily the position of the card 

in the system. If the selector does not select the expected channel, check that 

the address for the required amplifier module is correctly set. 

RACK Displays the selected rack. This is only appropriate for systems containing 

more than one rack and having a 651 in the expansion racks. Rack 0 is the rack 

containing the 650 module. 

▲ Used in conjunction with the CHAN and RACK push-buttons, increases the 

selected module and rack. 

▼ Used in conjunction with the CHAN and RACK push-buttons, decreases the 

selected module and rack. 

Fig. 1 Front Panel for 650 and 651 
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A Used in conjunction with the INPUT and displays channel A of the selected 

channel/rack. 

B Used in conjunction with the INPUT and displays channel B of the selected 

channel/rack. 

EX Used in conjunction with the INPUT and displays the excitation voltage of the 

selected channel/rack. 

For example, to change the selected channel from rack 0, channel 1a to rack 1 channel 2b 

do the following:- 

 

Press the RACK button once and use the ▲ button to change from rack 0 to rack 1. 

Press the CHAN button once and use the ▲ button to change from chan. 1 to chan. 2. 

Press the INPUT button to tell the 650 to display the channel data in Volts. 

Press the B button to select channel b of the selected channels. Note that not all amplifier 

modules have 2 channels. 

 

2.2 What the 650 displays. 

 

The 650 will display the output of the selected channel in volts. Even when the 650 has 

been given scaling values for a channel via its serial port, the data is still displayed in volts. 

 

 

3.0 SERIAL INTERFACE CHOICE AND CONNECTIONS. 
 

3.1 Deciding which serial interface type to use. 

 

For a single 650 connected to a computer, use RS232 

via the lead supplied. The factory defaults for the 650 are 

set to RS232. Using the standard 2m lead would mean 

that the baud rate could be as shown. The environment 

refers to the amount of electrical noise generated from 

other computers and machinery. Less is best! 

<19.2k baud Nearly all 

environments 

38.4k baud Most 

environments 

57600 baud Some 

environments 

 

If you require a longer lead, up to 15m can be used. It should be made from high quality 

twisted pair cable. Above 10m cable length, 57600 baud may be unreliable. For lead 

lengths greater than 15m use RS485.  

 

For applications where there is more than one instrument connected to the network, RS485 

should be used. If RS485 is used, a converter may be necessary to convert RS485 to 

RS232 in order to match the host computer's serial port. RDP sell such a device and as 

there are problems caused by software handshaking, we recommend that the device that 

we have specifically tested is used. 

 

RS422 is not normally used. 

 

3.2 Which connector to use on the rear of the 650. 

 

The serial lead plugs into 

different connectors 

depending on the type of 

housing. 

Housing Type Connector Connections A and B 

are internally 

connected, so either A 

or B may be used. 

602 (270mm wide) 4A or 4B 

603 (360mm wide) 8A or 8B 

604+ (483mm wide) 13A or 13B 
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3.3 Connections & Solder Pad Setting for all supported serial protocols. 

 

See sections 3.4 to 3.5 for connection diagrams 

 

Connections for 650 end of serial lead & Solder Pad Selection 

The serial connectors have different pin-outs 

depending upon the serial protocol used. Once you 

have decided upon the protocol, the 7 pin DIN 

connector should be wired as shown. Additionally, it 

may be necessary to change some solder ad links 

on the main 650 circuit board.  The diagram below 

shows the locations of the solder pads. The factory 

configuration is RS232. REFER TO 650 REMOVAL 

INSTRUCTIONS under Fig. 2. 

 

Note, regardless of the protocol used, it may be 

necessary to use RS232 so do not re-wire the lead 

supplied or make solder pad changes until the 

necessary pre-checks are done. See section 5. 

PIN / Solder 

Pad 

Serial Protocol 

RS232 RS422 RS485 

Pin 1 TX TX-A TX/RX-A 

Pin 2  TX-B TX/RX-B 

Pin 3 RX RX-A  

Pin 4  RX-B  

Pin 5 Ground   

Pin 6 Screen   

Pin 7    

SP5 link A to D A to C A to C 

SP6 link A to D A to C A to C 

SP7 link A to C A to C A to B 

SP8 link A to D A to C A to B 

SP9 link A to C A to B A to B 

RS422 and RS485 also require line termination resistors detailed in the sections following. 

 

Fig. 2 Location of Solder Pads for Serial Communication Selection 

 

If the system has 651 modules fitted, care should be taken when removing the 650 as a 

ribbon cable connects the 650 and 651 modules. 

 

To remove the 650, turn off power, undo the 4 screws on the front panel and withdraw unit. 

Anti-static precautions should be observed whilst handling the circuit board. 

 

Note Solder pads SP1-4 and SP10-12 are for galvanic isolation and should not be 

changed. 
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3.4 RS232 Communication Summary & 

Connections 

 

See section 3.3 for solder pad settings but note 

that default settings are for RS232 so changes 

may not be necessary. 

 

Allows a single 650 to be connected to a PC 

using a good quality screened three-core cable.  

To simplify setting up and configuration, the 650 

is configured in the factory for RS232 

communication at 9600 baud and is supplied with 

a 2m RS232 serial interface lead. 

 

3.5 RS422 Communication Summary & 

Connections 

 

Due to the rarity of RS422 networks, they are not 

detailed here. Please contact RDP for information on connections. 

 

3.6 RS485 Communication Summary & Connections 

 

See section 3.3 for solder pad settings. NOTE, before changing solder pad links for RS485, 

connect using the RS232 lead and configure the software on the 650 for RS485 

communications. See the section 5 and the SET COMMS instruction for details of how to 

do this. 

 

Allows up to a maximum of two hundred and fifty six 650's to be connected to a single PC 

using a good quality dual pair cable (e.g. Belden 9841). If more than 32 units are used, or 

the network spreads over hundreds of metres, it may be necessary to use one or more line 

boosters. 

 

To connect the RS485 network to the PC, a RS232 to RS485 converter will be required 

such as the Amplicon Model MA485F9 (see Figure 5 for connection details).  

 

RS485 Line Termination 

 

In RS485 applications, the two transmission lines must be properly terminated, and a single 

resistor across the receiver input pair on the Model 485F9 normally provides adequate 

termination at the computer end.  It is important  that the last 650 in the network is 

terminated by linking solder pad SP5 A-B as well as SP5 A-C. 

 

RS485 Network Biasing Resistors 

 

In some instances, particularly in RS422/RS485 multi-drop operation, noise may be 

detected at the receiver.  In the multi-drop configuration, there can be brief periods when 

no transmitter is enabled, the network is allowed to float.  So it may be required to add 

extra resistors to the RS232 to RS485 converter, so that the network is biased to about 1 

to 2 volts when all transmitters are enabled (please refer to manufacturers instructions for 

further information). 

 

 

Fig. 3 Connections for RS232 lead. 

 

The links between pins 1-4-6 and 7-8 at 

the computer end are essential due to 

the fact that the 650 uses software 

handshaking. 

1 
2 
3 
4 
5 
6 
7 
8 
9 

1 
2 
3 
4 
5 
6 
7 

 
RX 
TX 

 
GND 

TX 
 
RX 
 
SIG. GND. 
SCREEN 

2m 

9-pin D Type 
7-pin DIN Type 

(650 end) 

Yellow 

Red 

Green 
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Fig. 4 Connections for a typical RS485 lead. 

 

 

MA485 Jumper Positions  MA485 Switch Settings 

Link Description  1 2 3 4 Description 

J1 1-2 &  

J2 1-2 

RS232 con. Wired 

as PC serial card 

 x x x ON RS485 line termination on, 

termination resistor fitted 

J3 1-2 RS485 local echo 

disabled 

 ON ON ON x RS585 transmit 

turnaround time = 512us 

 

 

4.0 650 TO 651 CONNECTION DETAILS 
 

This section is appropriate only to systems having more than one rack, and having a 650 in 

one rack, and having 651(s) on the other(s). 

 

Each 651 connects is neighbour, or the 650 module via a ribbon cable. It is extremely 

unlikely that any changes or problems will be associated with the connection between the 

650 and the 651(s) 

 

The ribbon cable is connected to CONN3 of the 650. 

It connects to CONN2 (marked IN) on the first 651. A subsequent 651 would connect 

between CONN3 (marked OUT) on the 651 to CONN2 (marked IN) on the next 651, and so 

on. 

 

SW1 on the 651 sets the address of the sub-racks. The rack containing the 650 is rack 0. 

The first 651 should be set as 1 and so on. 

 

If you require any further assistance regarding the 651 contact RDP. 

 

 

5.0 SERIAL COMMUNICATIONS - CHOOSING THE BEST APPROACH 
 

There are 3 approaches to communicating with the 650 module. The information below 

summarises these and will enable you to make the correct choice. It is necessary for you to 

decide how you want to use the product. 

 

1 
2 
3 
4 
5 
6 
7 

TX-A 
TX-B 
RX-A 
RX-B 
 
Screen 

7-pin DIN A 

1 
2 
3 
4 
5 
6 
7 

7-pin DIN B 

1 
2 
3 
4 
5 
6 
7 

TX-A 
TX-B 
RX-A 
RX-B 
 
Screen 

 

7-pin DIN A 

1 
2 
3 
4 
5 
6 
7 

7-pin DIN B 

B 

A 

A’ 

B’ 

V+ 

GND 

1K 

1K 

9V 0V 

Amplicon MA485F9 
First 650 in network Last 650 in network 

1
2
0
R
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1 M650 Configuration Software for Windows 

 

If you want to use the 650 as a stand-alone data logger (that is not connected to a 

pc) and you do not wish to become familiar with the instruction sets, you can use the 

Windows based M650ConfigurationSoftware.exe. This provides step-by-step 

instruction on configuring the 650 unit. 

 

The program will have been supplied with your 650. 

 

2 Microsoft Excel Data Logger/Set-up Spreadsheets 

 

If you would like to get the data from your 650 directly into an Excel spreadsheet, 

then the set-up can also be done from the spreadsheet. Using this approach it is only 

necessary to configure the channels and then use the scan command to get data to 

the spreadsheet. From the spreadsheet, real time graphs can be set up, or any other 

of the functions of Excel used. 

 

The Spreadsheet will have been supplied with your 650. 

 

3 Serial Terminal Emulation Program 

 

If you intend to use the 650 in conjunction with your own software, we suggest that 

you either configure the unit using the approach detailed in item 1 or that you use the 

terminal program within the M650ConfigurationSoftware.exe to send instructions 

directly to the 650 module from the keyboard. This approach is useful for gaining 

experience in the functions of the various commands. 

 

A full summary of the commands and their syntax is contained within this manual. 

 

 

6 M650 CONFIGURATION SOFTWARE.EXE 
 

This M650 Configuration Software runs under Microsoft Windows environment and it has 

been designed primarily as a tool to assist in the configuration, calibration and 

programming of RDP's 650 Intelligent Computer Interface for the Microsoft Windows 

environment. 

 

6.1 Getting Started 

 

When the software is first started, a RDP copyright message will be displayed for a few 

seconds then you will be prompted to either create a New Configuration or Load Existing 

Configuration from the hard disk or go to the terminal program. 

 

New Configuration 

 

Click [New Configuration] if you are a new user or wish to create a new configuration then 

the software will guide you through creating a new configuration.   Clicking [Cancel] at any 

time will exit the set-up wizard and save the new configuration file. 
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Load Existing Configuration 

 

Will guide you through loading an existing configuration file off the hard disk.  If you do not 

specify an existing configuration file then a new file will be automatically created with the 

default settings.  Then the dialog box to Configure Communications will be displayed. 

 

Terminal Program  

 

This provides a facility to transmit typed instructions directly to the 650, and read the 

response. See terminal mode. 

 

Network GuideLines (rules for successful serial communication) 

 

To achieve successful and reliable serial communications, the following rules must be 

adhere to: 

 

a) The computer and all the instruments connected to the network must have the same 

communication protocol.  If RS422/485 communication is being used then a suitable 

RS232 to RS422/485 converter must be used. 

b) The computer and all the instruments connected to the network must have the same 

baud rate selected. 

c) All the instruments must have identical command prefixes and delimiters (data and 

end of line separators).  If the network has any E725 instruments connected then the 

command prefix must be '#'. 

d) Each instrument connected to the network must have an unique address. 

 

Note All the instruments connected to the network must have the following communication 

parameters: 

 

a) The end of line characters must be CR/LF (see SET DELIMITERS). 

b) The software handshaking must be set on (see SET COMMS). 

 

6.2 File Menu 

 

Creating a New Configuration 

 

Using the mouse click on the File menu, then click on Create a new configuration file, 

then a series of dialog boxes will guide you through creating a new configuration by: 

 

1) Configure Communications 

 

Displays a dialog box to set the serial communication parameters on the computer.  Note 

this does not program the communication settings of the instruments connected to the 

network. 

 

2) Add an Instrument to the Network 
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Displays a dialog box to set the add an instrument to the configuration file.  Note this 

option re-programs the instrument with current communication settings and the new 

instrument address. 

 

 

3) Modify 650 Configuration 

 

Displays a series of dialog boxes to modify the configuration.  Initially a dialog box will be 

displayed listing all the configured instruments, select the required instrument and click 

[OK]. 

 

Clicking [Cancel] at any time will exit the set-up wizard and save the new configuration file. 

 

Open an existing configuration file 

 

Using the mouse click on the File menu, then click on Open existing configuration file, 

then a dialog box will be displayed allowing a 650 configuration file to be selected.  Note 

the computers communication settings will be modified automatically. 

 

Save configuration file 

 

Using the mouse click on the File menu, then click on Save configuration file, then a 

dialog box will be displayed allowing a file name to be entered. 

 

Print Instrument Configuration 

 

Using the mouse click on the File menu, then click on Print Instrument Configuration, 

then a dialog box will be displayed listing all the configured instruments, select the required 

instrument and click [OK]. 

 

Exit 

 

Using the mouse click on the File menu, then click on Exit, to exit the M650 configuration 

software. 

 

 

6.3 Edit Menu 

 

Add Instrument to the Network 

 

Using the mouse click on the Edit menu, then click on Add Instrument to the Network, 

then a dialog box will be displayed allowing a new instrument to be configured.  See on-line 

help for further information. 

 

Delete Instrument Configuration 

 

Using the mouse click on the Edit menu, then click on Delete Instrument Configuration, 

then a dialog box will be displayed listing all the configured instruments,  select the 

required instrument and click [OK]. 
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Modify 650 Configuration 

 

Using the mouse click on the Edit menu, then click on Modify 650 Configuration, you will 

then be presented with a series of dialog boxes to modify the configuration.  Initially a 

dialog box will be displayed listing all the configured instruments, select the required 

instrument and click [OK].  See on-line help for further information. 

 

6.4 Comms Menu 

 

Configure Communications 

 

Using the mouse click on the Comms menu, then click on the Configure 

Communications menu and then you will be presented with a dialog box to set the 

following serial communication parameters on the computer.   See on-line help for further 

information. 

 

Note This does not program the communication settings of the instruments connected to 

the network. 

 

 

If you are not sure about the communication settings of the instruments connected to the 

network then switch the instrument OFF and ON (POWER ON COMMS SUMMARY. 

 

 

Scan Network for Connected Instruments 

 

Using the mouse click on the Comms menu, then click on Scan Network for Connected 

Instruments menu, then a dialog box will be displayed stating that NO INSTRUMENTS 

FOUND.   Enter the address of the last instrument on the network and click [Scan 

Network] to scan the network for any connected instruments, using the current comms 

configuration (see POWER ON COMMS SUMMARY).  Any instruments found will be listed 

with the instrument address, instrument type and software version. 

 

Program Instrument 

 

Using the mouse click on the Comms menu, then click on Program Instrument menu, 

then a dialog box will be displayed listing all the configured instruments,  select the 

required instrument and click [OK]. 

 

Terminal Mode 

 

Using the mouse click on the Comms menu, then click Terminal Mode,   the terminal 

mode allows commands to the sent  to the network.  For example, type #00 SYS in the 

transmit window followed by the enter key will send the SYS command to the 650 (module 

address 00) and the response from the 650 will be displayed in the receive window.  To 

clear the either the transmit or receive windows position the mouse pointer over the 

appropriate clear button and click the left hand mouse button.  To exit terminal mode click 

on the Terminal Mode menu option. 

 

If any instruments have been configured then the following options will be displayed: 
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a) Select a specific instrument (i.e. destination) for the Log and Scan commands. 

 

b) The Data Logging option (Log button), prompts for the name of the data output file 

before sending the RUN command to the selected instrument.  From this point, any 

data received from the network will be saved in the specified file.  Clicking the log 

button a second time will send the END command to the selected instrument and stop 

data logging.  Note Exiting terminal mode will stop data logging. 

 

c) The Scan button sends the SCAN command to the selected instrument. 

 

An alternative method of data logging is to use either the RUN or SCAN commands is as 

follows: 

 

a) Use either the RUN or SCAN commands to acquire data. 

 

b) Position the mouse pointer at the start of the first data item. 

 

c) Press (and hold) the left hand mouse pointer, then move the mouse pointer to high 

light all the required data. 

 

d) Press <Ctrl><C> to copy the data onto the clipboard. 

 

e) Open either MicroSoft Excel or Word and then press <Ctrl><V> to copy the data from 

the clipboard. 

 

6.5 Timed Backup 

 

Using the mouse click on the Options menu, then click on Timed Backup, you will be 

presented with a dialog box to enable/disable the automatic backup option and set the time 

interval in  minutes between saves. 

 

7 MICROSOFT EXCEL DATA LOGGER/SET-UP SPREADSHEETS 
 

The details of the use of this facility are covered in a separate document, reference 

CD1425. The document is on the CD supplied with the 650. 

 

Points of note are: 

 

1 The configuration required is minimal. The required channels must be configured 

(using the set channel command) and then the settings save using the save 

command. It is not necessary to configure any of the data logging functions as they 

are not required 

 

2 The Excel Spreadsheet has a command area into which the command is entered to 

instruct the 650 to send its data. The simplest command to use is the SCAN 

command, which instructs the 650 to send the data from all enabled channels, in 

ascending order of their channel number 
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8 SERIAL TERMINAL EMULATION PROGRAM 
 

The terminal emulation program is available within the M650ConfigurationSoftware.exe. 

program supplied by RDP with the 650 unit.  Its function is to turn your PC into a terminal 

emulator so that anything you type on the keyboard will be sent to the 650, and any 

response from the 650 will be sent to the monitor. 

 

To access this software, run the M650ConfigurationSoftware.exe and from the menu select 

Terminal. 

 

This allows you to see the response to each command and test any instructions that you 

may be planning to send. 

 

Please note that characters are sent as you type them so if you make a mistake, you will 

have to press enter and allow the 650 to report an error, before staring the line again. 

 

8.1 Establishing serial Communications 

 

Before connecting the 650 system into any large networks, it is essential that you 

familiarise yourself with the operation of the unit on a simple one to one network with the 

host computer. 

 

Connect the 650 to the host computer using the RS232 lead supplied. 

 

Open the terminal program on the host PC. 

 

Type '#00 sys' and then press ENTER 

The unit should respond with an identification string, if it does, all is well, if not, check 

section 6. 

 

9 650 SERIAL COMMANDS 
 

The communication interface between the 650 and the host computer has been designed 

to be very flexible by using simple English commands.  This makes it very simple to 

program the 650 using a terminal emulation program (see sections 8) or alternatively any 

high-level programming language with ASCII based string functions (such as Visual Basic, 

Delphi, Pascal etc) can be used to develop data acquisition and control software. 

 

Since the 650 can be used on a RS422/RS485 network, all units expect to be sent a two 

digit hexadecimal address before any command, this address must be preceded by # and 

the command line must be terminated by a carriage-return.  If the address of the command 

line does not match the programmed address of the 650 then the command will be ignored. 

 

For example, suppose we want to set the real time clock on the 650 with 

address zero to 3pm, then the following command must be sent: - 

 

 #00 SET TIME,15:00:00 

 

In this section, all the 650 commands will have the following format :- 

It is important 

to remember 

that all 

instructions 

sent to the 

650 must be 

terminated 

with a 

carriage-

return line-

feed 

sequence. 
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 #nn COMMAND,P1,P2   

 

where #nn Please substitute nn with the address of the 650 module with which you 

wish to communicate. 

 

 COMMAND The command to be sent. 

 

 ,P1,P2 Optional command line parameters. 
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9.1 650 commands – Quick Reference 

 

All commands must be prefixed with '#nn '  where nn is the address of the 650 unit. 

 

Command Description 

SYS Prints the software version number. 

CLR DATA Clears all acquired data from the 650 memory. 

CLR ERROR Clears the error flag and counter. 

CLR CHANNEL Clears the specified channel to the default values. 

CLR CHANNELS Clears every channel to the default values. 

CLR ALL CHANNELS Clears every channel to the default values. 

CLR PASSES Clears passes one to eight to the default values. 

CLR LOGSPEC Clears the data logging parameters to the default values. 

CLR ZERO Clears tare readings to zero. 

SET COMMS Defines serial communication parameters. 

SET DELIMITERS Defines data separators. 

SET DATE Programs the real time clock (650ME1 unit only). 

SET TIME Programs the real time clock (650ME1 unit only). 

SET CHANNEL Defines channel set up parameters. 

SET CHANNEL SCALING Enables the specified channel, setting the scaling & format. 

SET PASSES Defines data acquisition rate and start/stop conditions. 

SET HYSTERESIS Defines the hysteresis for the start/stop conditions. 

SET LOGSPEC Defines the data logging parameters. 

GET ERROR Gets the error flag and counter. 

GET CHANNEL Reads the selected channel. 

GET DATA Reads the contents of the data buffer. 

GET DATE Reads the real time clock (650ME1 unit only). 

GET TIME Reads the real time clock (650ME1 unit only). 

SAVE Saves all the set up parameters to E2PROM. 

RESET Causes the 650 to re-start. 

ZERO Zeros all channels having zeroscan enabled. 

MEM SCAN Scans all the enabled channels to memory. 

SCAN Executes a single scan of all the enabled channels, and 

transmits the data to the serial port. 

RUN Executes the programmed data acquisition parameters. 

END Terminates data acquisition. 

 

9.2 Channel Address Entry Format 

 

When a channel address is entered, it should be entered in the format rmmc where r is the 

rack number, mm is the 2 digit address for the amplifier module and c defined if the channel 

is channel a or b. 

 

For example, to get the value of the channel in rack 0 (the one with the 650 in), module 

address 03 channel b, the command would be  

 

#00 get channel,003b 
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9.3 650 Commands - Detailed Description 

 

REMEMBER! All commands must be prefixed with '#nn '  where nn is the address of the 

650 unit. 

 

#nn SYS 

 

Prints the software version number. 

 

#nn CLR DATA 

 

Sending this command causes all of the data stored in memory to be cleared. WARNING:- 

This command is effective immediately and once cleared, the data cannot be restored. 

 

#nn CLR ERROR 

 

Causes the error counter to be reset. The error counter stores the number of commands 

which have been received since the last CLR ERROR command and before an erroneous 

command. 

 

#nn CLR CHANNELS 

#nn CLR ALL CHANNELS 

 

Both clear the set-up of all channels. 

 

#nn CLR CHANNEL,Address 

 

Clears the set-up of the specified channel. See 9.2 for format of Address. 

 

#nn CLR PASSES 

 

Clears passes one to eight to the programmed default values (see section 11.4). See SET 

PASS for details of PASS function 

 

#nn CLR LOGSPEC 

 

Clears the data logging parameters to the programmed default values (see section 11.4). 

 

#nn CLR ZERO 

 

This command will only affect channels with the tare facility enabled and it will set the tare 

reading for these channels to zero. See SET CHANNEL command for details of enabling 

tare facility. 
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#nn SET COMMS,Address,Protocol,BaudRate,HandShaking 

 

Sets up the communications parameters for the 650. 

 

Changing the Address and Mode will have an immediate effect on the 650 comms.  

The new baud rate will be set after the OK prompt has been transmitted to the computer.  

If the unit is switched off or the RESET command is sent, the changes will be lost inless 

they are saved in the E2PROM using the SAVE command. 

 

Address Sets the module address of the 650.  This only needs to be changed if a 

number of 650 units are connected to the same RS422 or RS485 network.  

Acceptable values are 00 to FF hexadecimal. 

 

Protocol Sets the communications protocol for the 650.  Acceptable values are 232, 

422 or 485. 

 

BaudRate Sets the communications baud rate of the 650.  Acceptable values are 600, 

1200, 2400, 4800, 9600, 19200, 38400 or 57600. 

 

HandShaking Sets the response made by the 650 to a command.  If OFF then the 650 

does not make any response to commands otherwise if ON 650 will respond 

with OK<EOL1><EOL2> or ERROR<EOL1><EOL2> if the command was 

erroneous. 

 

Where <EOL1><EOL2> are the current values set for DELIMITERS. See 

SET DELIMITERS command description. 

 

For example, to set the 650 address to zero, RS232 communication at 9600 and software 

hand-shaking the command would be :- 

 

#00 SET COMMS,00,232,9600,ON 

 

#nn SET DELIMITERS,@DatSep1@DatSep2,@EOL1@EOL2 

 

Sets the codes which separate the data and come at the end of each line of data. E.g. 

 
DATETIME[DS1][DS2]Data1[DS1][DS2]Datan[EOL1][EOL2] 

 

Where [DS1][DS2] are data separators 1 and 2. 

 [EOL1][EOL2] are end of line characters 1 and 2. 

 

Codes for some common data 

separators and end of line characters 

are. Note, the DECIMAL values should 

be used & they do not print! 

Null (nothing) = 00 Carriage-Return = 13 

TAB = 09 Line-Feed = 10 

Space = 32 COMMA = 44 

Semicolon = 59   

 

For example, to configure the 650 output file to be compatible with MicroSoft Excel (i.e. 

data separator = TAB and the end of line characters are carriage-return, line-feed) the 

command would be: - #00 SET DELIMITERS,@09@00,@13@10 
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#nn SET DATE,DD/MM/YYYY (Only available with 650ME1 unit) 

 

Sets the date on the internal real time clock.  The format must be as shown above, for 

example to program the date 1st. February, 2000 the command would be :- 

 

 #00 SET DATE,01/02/2000 

 

#nn SET TIME,HH:MM:SS (Only available with 650ME1 unit) 

 

Sets the time on the internal real time clock.  The time is based on the twenty four hour 

clock and the format must be as shown above, for example to program the time 3.54pm the 

command would be :- 

 

 #00 SET TIME,15:54:00   

 

#nn SET CHANNEL,Address,Enabled,TareFacility,Scaling,Offset,TarePoint,Format 

OR 

#nn SET CHANNEL SCALING,Address,Scaling,Offset 

 

This command sets up the logging values for the specified channel. One must be specified 

for each channel, which needs to be logged. At least one MUST be specified in order for 

logging to work. SET CHANNEL SCALING is just an abbreviated form of SET CHANNEL. 

Using SET CHANNEL SCALING automatically enabled the channel and sets the format. 

 

NOTE, BOTH OF THESE COMMANDS AUTOMATICALLY CLEAR ALL LOGGED DATA IN 

THE MEMORY OF THE 650. 

 

Address Is the address of the channel to be set up, format is abbc where a is the rack 

number, bb is the module address and c is channel a or b.  For example, to 

address module 3, channel a in the rack fitted with the 650 the address would 

be 003a. 

 

Enabled This turns a channel on or off. If ON a channel will be logged, if OFF the 

channel will be ignored. 

 

TareFacility This enables the tare facility (see TarePoint).  If ON the channel will respond 

to the ZERO and CLR ZERO commands, it OFF these commands will be 

ignored by this channel. 

 

Scaling The 650 assumes that the full scale of an input channel is 10V and if the 

scaling factor were 1, the channel would be stored in Volts.  The value 

entered here is the multiplier required to convert the ±10V input signal into 

engineering units.  In summary, the calculation for the scaling factor is: 

 

 
Scaling Factor = 

Full Scale Value (Engineering Units) 

Full Scale Value (Volts) 
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The input to the 650 can be monitored by selecting the required channel from 

the front panel (see Using the 650 in monitor mode). 

 

Offset This is the zero offset one wishes to apply to the stored data.  For example, if 

one wished to store 0 to 10mm instead of ±5mm the offset value would be 5.  

The best accuracy is achieved by scaling all bipolar channels as ±10V and 

applying the offset (if required) with this parameter. 

 

TarePoint If the channel is enabled for the tare facility then this value is used to derive 

the tare reading when a ZERO is sent to the 650.  The tare reading is 

calculated as follows: 

 

 Tare Reading = ADC Reading x Scaling + Offset - Tare Point 

 

Format A two digit number (LT). L=leading digits, T=trailing digits. This sets the 

number of digits stored. For example 23 would result in a number with 2 digits 

before the decimal point and three digits after. (eg 12.345). The maximum 

number of digits is eight. (i.e. L+T must be 8 or less however more than 5 

digits will exceed the resolution of the A to D converter.) 

 

For example, if channel 001A has a ±25mm LVDT, calibrated ±10V for ±25mm which one 

wishes to store as 0 to 50.000, with the tare facility enabled and a tare point of zero, the 

command would be: - 

 

 #nn SET CHANNEL,001A,ON,ON,2.5,25,0,23 

or  

#nn SET CHANNEL SCALING,001A,2.5,0 to set just the scaling and tare. 

 

 

#nn SET PASS,PassNumber,Interval,Function,StartCondition,StopCondition 

 

This function sets up the logging rate and start/stop conditions for a data logging step or 

PASS.  A PASS is one of the eight data logging stages which can be defined and allows 

the operator to define different data logging rates etc. within one test. 

 

For example, one may wish to acquire data very rapidly at the start of a test but less rapidly 

as the test continues.  One of the ways of doing this is to specify a number of PASSES 

each with progressively slower data capture rates. 

 

Alternatively one may wish to vary the data capture rate according to the value of one of 

the channels.  This can be achieved by assigning PASSES which start and stop based on 

the value of one or more channels.  Several examples of test applications are available in 

this manual. 

 

All passes are executed in turn starting with pass 1 and ending with the pass with 

the highest number.  A new pass cannot start until the stop condition for the 

previous pass has been met. 

 



 23 

PassNumber This defines a pass number and the order in which the pass will be 

processed.  The 650 will log at the values defined in PASS 1 first and then 

continue to PASS 2 etc., if more passes are defined.  A subsequent pass 

cannot start until the stop condition of the previous pass has been met and 

the start condition of the subsequent pass has been met.  Acceptable 

values are 1 to 8. 

 

Interval This defines the time period between scans.  A scan is a single capture of 

all of the enabled channels in the system.  For example, if twelve channels 

are enabled, a scan will involve twelve channel readings.  Acceptable 

values are 0.01 to 59999 seconds. 

 

Function If you require a constant time between scans, set this value to 0. Any other  

value entered will change the scan period by the specified percentage for 

each pass (see formulae below), thus enabling logarithmic data logging 

rates. 

 t(x+1) = t(x) + ft(x) 

Where t(x+1) = Next time interval between scans. 

 t(x) = Current time interval between scans. 

 f = Fixed multiplier, expressed as a percentage. 

Exmple, a positive number will cause the scan interval to increase (i.e. the  

logging rate gets slower) and a negative number will cause the scan 

interval to decrease (i.e. the logging rate gets faster).  However, if this 

function is not  required then enter 0. We suggest that you simulate the 

effect of the multiplier in a spreadsheet to see the effect on the logging 

interval. 

 

StartCondition Defines the scan start condition. Summary of start conditions as follows: 

IMM,,,, (the commas are essential) 

Logging starts immediately if it is pass 1, or as soon as soon as the 

previous pass has finished if it is not pass 1 

 

BUTTON,,,, (the commas are essential) 

The pass starts as soon as the front panel ▲ button is pressed. 

 

DELAY,Number_Of_Seconds,,, (the commas are essential) 

The pass starts after the specified delay of 0.01 to 59999 seconds. 

 

LEVEL,Value,Channel,Condition, 

Logging starts when the value of the channel meets condition. See 9.2 for 

details of channel number entry 

Conditions are: H Channel level is higher than Value. 

 L Channel level is lower than Value. 

 LH Channel level rises through Value. 

 HL Channel level falls through Value. 

Also, see SET HYSTERESIS 

 

TIME,Time,Date,, (The commas are essential) 

The pass starts at the specified time and date.  This function is only 

available on the 650ME1 unit. 

 Time. The required time HH:MM:SS 
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 Date. The required date DD/MM/YYYY. 

If the date parameter is not entered, the pass will start at the time entered 

on the current date. In order to log at the same time every day, set multiple 

iterations and do not define a date. 

 

 

 

 

 

StopCondition Defines the scan stop condition. Summary of stop conditions as follows: 

BUTTON,,,  (the commas are essential) 

The pass stops as soon as the front panel ▼ button is pressed. 

 

DURATION,Number_Of_Seconds,,  (the commas are essential) 

The pass stops after the specified duration of 0.01 to 59999 seconds. 

 

BURST,Number_of_scans,, (the commas are essential) 

The pass stops after the specified number of scans. 

 

LEVEL,Value,Channel,Condition 

Logging stops when the value of the channel meets condition. See 9.2 for 

details of channel number entry 

Conditions are: H Channel level is higher than Value. 

 L Channel level is lower than Value. 

 LH Channel level rises through Value. 

 HL Channel level falls through Value. 

Also, see SET HYSTERESIS 

 

 

#nn SET HYSTERESIS,Value 

 

This command sets the amount of hysteresis that is applied to the following start/stop 

conditions: 

 

i) Waiting for the input signal to pass through a pre-defined set point (high to low 

transition). 

 

ii) Waiting for the input signal to pass through a pre-defined set point (low to high 

transition). 

 

Value Is the global amount of hysteresis applied to the set points in engineering units. 
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#nn SET LOGSPEC,Passes,Iterations,Clock,Duration,Medium,Format,Serial,Auto 

 

This command sets up the data logging parameters, and the command line parameters are 

as follows :- 

 

Passes Enter the number of passes (log stages) you have defined. 

 

Iterations Enter the number of times you want the whole test to repeat (between 1 and 

99). A test is from the beginning of pass1 to the end of the last pass. If you 

enter 0, the test will repeat infinitely or util interrupted. 

 

Clock Defines if the data is time and date stamped. For the 650ME1 acceptable 

values are ON or OFF but for the 650 this must be off at the 650 does not have 

a real time clock. 

 

Duration If set to ON the elapsed time since the last new pass or iteration began will be 

logged in seconds. If set to OFF, the elapsed time will not be logged. 

 

Medium If set to COMM the data will be logged directly to the serial communications 

port in either the ASCII, hexadecimal or binary format as specified by the 

Format parameter.  If set to MEMORY then the data will be logged to internal 

memory which can be later dumped to the host computer in the specified 

format. 

 

Format This specifies the format for the data and is normally set to ASCII but could be 

BIN or HEX 

 

Serial If set to ON, the 650 will respond to serial transmissions during logging.  

Logging can therefore be interrupted. 

If set to OFF the unit will ignore all communications on the network.  This 

facility is of most use when the 650 units are on a network. All of the 650 units 

will evaluate an instruction on the port to check the address of the unit to which 

the instruction is directed.  It is possible that the time taken to evaluate an 

instruction may interfere with logging.  Therefore, in this situation it is better to 

instruct the 650 to ignore the communications ports whilst it is logging. 

The down side is that once the serial communications are turned off, it is not 

possible to interrupt a logging run via the serial port.  For RS232 systems with 

a single 650, it is better to leave the serial port turned ON. 

 

Auto If set to ON, the 650 will automatically go to RUN mode when it is switched on.  

Logging will start once the StartCondition for PASS 1 is met (see SET PASS).  

This is useful when the 650 is to be used without a computer connected. 

If this is set to OFF, a computer will be required to send a RUN  command 

before data can be captured. 
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#nn GET ERROR 

 

The unit returns either the number of command lines it had received before the erroneous 

line and after the last CLR ERROR command or OK if no errors have occurred. 

 

This facility allows a number of lines of command to be sent in a block and then error 

checked afterwards.  

 

The GET ERROR command only returns the line number on which the FIRST 

error occurred.  Also please ensure that the CLR ERROR command is used 

before the set up lines are re-sent. 

 

 

#nn GET CHANNEL,Address 

 

This request causes the 650 to return the current data value of the specified channel. See 

9.2 for address format 

 

#nn GET DATA 

 

This instructs the 650 to down-load the data in memory to the serial communications port. 

The data separators and end of line codes will be as defined in the SET DELIMITERS 

command, please see SET LOGSPEC,Format for a detailed description of the data 

transmitted. 

 

#nn GET DATE (Only available on 650ME1) 

 

The unit returns the current date followed by the defined end of line codes.  Format is 

DD/MM/YYYY. 

 

#nn GET TIME (Only available on 650ME1) 

 

The unit returns the current time followed by the defined end of line codes.  Format is 

HH:MM:SS. 

 

#nn SAVE 

 

The 650 has a volatile and a non-volatile memory area. When logging, commands from the 

volatile memory area are used. The SAVE command writes the commands and settings 

from the volatile memory area to the non-volatile (EEPROM) area. 

 

On start-up or after a RESET command, valued from the EEPROM are loaded into volatile 

memory. 

 

#nn RESET 

 

Completely resets the 650 (the same as turning off, then on). Volatile memory is over 

written by settings from EEPROM. 
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#nn ZERO 

 

This causes all of the channels with the TareFacility enabled to be compared against the 

programmed TarePoint to calculate a tare reading for each channel.  The tare reading is 

calculated as follows :- 

 

 Tare Reading = ADC Reading x Scaling + Offset - Tare Point 

 

#nn MEM SCAN 

 

This command causes a single scan of all the enabled channels, the data is stored in 

memory and it can be retrieved at a later date using the GET DATA command. 

 

Note This is a global command (i.e. all 650’s connected to the network respond 

to the command and nn must be sent not the 650 module address. 

 

 

#nn SCAN 

 

This command causes a single scan of all the enabled channels, the data is transmitted 

immediately to the serial communication port in the specified data transmission format. 

 

 

#nn RUN 

 

This causes the 650 to go into RUN mode which means that it is waiting for the Start 

condition of PASS 1 to be met before logging actually starts. If the Auto is set to ON, the 

650 will automatically go to RUN mode when it is powered up. 

 

If the following have not been set up correctly, the RUN command will result in 

an ERROR. 

A) At least one channel must be configured. 

B) At least one PASS must be set. (see default values). 

C) The LOGSPEC command must be sent. (see default values). 

 

The display shows 'S 1' as the 650 waits for the start condition for PASS 1 and the 'P 1' as 

PASS 1 is performed. It then shows 'S 2', if and as it waits for the start condition of PASS 2 

and then 'P 2' as PASS 2 is performed etc. 

 

Following the completion of the test, the unit will return to monitor mode. 

 

 

#nn END 

 

The end command causes the unit to leave RUN mode and go to monitor mode.  This is 

useful if one wishes to terminate a test earlier than planned.  Also, a unit which is 
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configured with the Auto ON, must be sent this command before the unit will go to monitor 

mode and control can be regained. 
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10 CONFIGURING THE 650 FOR RS422 OR RS485. 
 

ONCE RS232 COMMUNICATIONS HAVE BEEN SUCCESSFULLY ESTABLISHED, it is 

necessary to change the 650 to the required new protocol. Using RS232, an instruction line 

must be sent, for which you will need to know the current baud rate (see section 6.1) and 

the new address of the 650 unit.  

 

Run the RDP terminal program (see section 8) 

 

If there is an existing network containing other 650 units, the address of the new unit 

should be the next available address, and the baud rate to the baud rate of the existing 

network. 

 

If there is no existing network, the address of the unit should be changed to 01, and the 

baud rate set to the existing value (it can be changed later if required). 

 

To change the communications settings send the command 

 

#00 SET COMMS,XX,YYY,ZZZ,ON  then press enter 

 

Where  XX  is the new module address and 

And  YYY is the communication protocol (either 422 or 485) 

And  ZZZ is the required baud rate, either 600,1200,2400,4800,9600,19200, 38400 or 

57600 

 

The unit should respond with OK 

 

Then send  

 

#nn SAVE  then press enter 

 

 where nn is the new address as set above. 

 

The unit should respond with OK. 

 

The unit can now be configured with the appropriate connections and solder pad settings 

(see section 3.3) and connected into the network. 

 

11 SERIAL COMMUNICATION PROBLEMS 
 

Check the baud rate. Check that the serial lead is connected to the correct socket on the 

600 system. Check that the address you are using is correct. Failing this, please follow the 

diagnostics routines detailed below. Change the solder pad connections back to the RS232 

settings (see section 3.3). Connect the 2m RS232 lead supplied by RDP between the 650 

and the host computer. See section 3.2 for details of the correct socket to use on the 650 

system. Run the terminal program supplied by RDP.  

 

MOST COMMUNICATION PROBLEMS ARE CAUSED BY INCORRECT CONNECTIONS. 

CHECK THESE AND THEN CHECK AGAIN. 
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Type the command #00 sys, them press ENTER. An ID string should be returned. If it is, 

communications are successful. If not proceed to 11.1. 

 

11.1 Establishing 650 Communication Settings (Display during Start-up) 

 

In order for communications to be successful, both the computer and the 650 must have 

the same communication settings. To find out the settings of the 650, turn it off, then on 

again and write down the display sequence. It runs as follows: - 

 

a) Instrument Identification (e.g. 650). 

b) Software Version Number (e.g. 1.06) 

c) Summary of the current COMMS settings in the format 'XX.Y.Z' for five seconds. 

 Where XX = Module Address (a 2 digit number, e.g. 00) 

  Y = Communication Mode: 0 = RS232 1 = RS422 2 = RS485 

  Z = Baud Rate: 0 = 600 1 = 1200 2 = 2400 

    3 = 4800 4 = 9600 5 = 19200 

    6 = 38400 7 = 57600  

 

Check that the address of the 650. Type the command #nn sys (then press ENTER) where 

nn is the address to which the 650 is set. If the ID string is not sent proceed to 6.2 

 

11.2 Matching the 650 Baud Rate to the Computer Baud Rate 

 

Establish the 650 baud rate as detailed in section 6.1. In the terminal program settings, 

change the baud rate to the same value as the 650 unit. Type the command #nn sys (then 

press ENTER) where nn is the address to which the 650 is set. If the ID string is not sent 

proceed to 11.3 

 

11.3 Resetting Serial Comms to Factory Values (POWER-ON RESET) 

 

You can set the 650 back to default values as 

follows; turn the unit off then hold the ▲ and ▼ keys 

and turn the unit on. The settings will be as follows: 

Address = 00 

Communications mode = RS232 

Baud rate = 9600 

 

Note that these settings are volatile, if the unit is turned off, the settings will revert to the 

values saved. Re-try the communications with these settings. Full default values are 

detailed in 11.4. If this fails, again check the connections. Otherwise, contact you supplier. 

 

11.4 650 Default Software Settings (after power on reset) 

 

Unless specified otherwise, the 650 will have the following settings when supplied. To 

return a unit to these settings one must perform a POWER ON RESET.  For details of how 

this is done refer to section 6. 

 

Serial Communication Settings (COMMS) 

Command which would set default values: 

 #00 SET COMMS,00,232,9600,ON 

 i.e. Module Address = 00 

 Protocol = 232 

Baud Rate = 9600 
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Hand-Shaking = ON 

 

Data Separators 

Command which would set default values: 

 #00 SET DELIMITERS,@09@00,@13@10 

 i.e. Data Separator 1 = @09 (Tab) 

 Data Separator 2 = @00 (Null) 

End Of Line 1 = @13 (Carriage-Return) 

End Of Line 2 = @10 (Line-Feed) 

 

Data Logging Specification 

Command which would set default values: 

 #00 SET LOGSPEC,1,1,OFF,OFF,COMM,ASCII,ON,OFF 

 i.e. Number of Passes  = 1 

 Number of Iterations = 1 

Log Real Time Clock = OFF 

Log Test Duration = OFF 

Logging Medium = COMM 

Data Transmission Format = ASCII 

Serial Reception = ON 

Autoexec = OFF 

 

Test Pass Specification 

Command which would set default values: 

 #00 SET PASS,1,1,0,IMM,,,,BURST,1,, 

 i.e. Pass Number = 1 

 Scan Interval = 1 

Function = 0 

Start Condition = IMM 

Stop Condition = BURST,1 

 

12 GENERAL SPECIFICATION 
 

General 

 Display ±10.000 LED for data & selected channel reference to simplify 

cal and set-up.  Display is also used to display the logging 

status (see RUN command, section 7.2 for further information). 

 Sample Rate 1 Hz 

 Linearity ±0.005 % FS 

 System Accuracy ±0.03% FS 

 Temperature 

Coefficient 

Zero 0.002% FS/ºC typical 

Gain 0.005% FS/ºC typical 

 Input Signal ±10v for ±10.000 display 

 Supply ±15v (+125mA, -2.6mA) 

 Channels 164 

 Dimensions Height 133.35 mm (3U), Width 81.28 mm (16HP) 

 Controls Input, channel and rack selection 

 Operating temperature 0 to 60ºC 

Serial Communication 

 Standards RS232, RS422 and RS485 
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 Protocol 1 start, 8 data and 1 stop bit, no parity. 

 Baud Rates 600, 1200, 2400, 4800, 9600, 19200, 38400, 57600. 

 Line Termination 120  (RS422, RS485 communication only). 

 650 Addressing 00 - FF Hex (RS422, RS485 communication only). 

 Maximum Cable Length 15m (RS232). 1200m (RS422, RS485). 

 Transient Suppression Standard. 

 Galvanic Isolation Optional. 

Analogue to Digital Converter 

 ADC 16 bit analogue to digital converter calibrated to read ±10.25 

volts full scale and with a typical conversion time of 17µS. 

Data Storage (max) 

 650 10240 channel readings.  Time and date stamping count as 

2 channel readings  650 ME1 65530 channel readings. 
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13. WARRANTY AND SERVICE 

 

WARRANTY. 

 

R.D.P. Electronics products are warranted against defects in materials or workmanship.  

This warranty applies for one year from the date of delivery.  We will repair or replace 

products that prove to be defective during the warranty period provided they are returned to 

R.D.P. Electronics. 

 

This warranty is in lieu of all other warranties, expressed or implied, including the implied 

warranty of fitness for a particular purpose to the original purchaser or to any other person.  

R.D.P. Electronics shall not be liable for consequential damages of any kind. 

 

If the instrument is to be returned to R.D.P. Electronics for repair under warranty, it is 

essential that the type and serial number be quoted, together with full details of any fault. 

 

SERVICE. 

 

We maintain comprehensive after-sales facilities and the instrument can, if necessary be 

returned to our factory for servicing. 

 

Equipment returned to us for servicing, other than under warranty, must be accompanied 

by an official order as all repairs and investigations are subject to at least the minimum 

charge prevailing at the date of return. 

 

The type and serial number of the instrument should always be quoted, together with full 

details of any fault and services required. 

 

IMPORTANT NOTES. 

 

1. No service work should be undertaken by the customer while the unit is under 

warranty except with the authorisation of RDP Electronics. 

 

2. If the instrument is to be returned to R.D.P. Electronics for repair, (including repair 

under warranty) it is essential that it is suitably packed and that carriage is insured 

and prepaid. R.D.P. Electronics can accept no liability whatsoever for damage 

sustained during transit. 

 

3. It is regretted that the above warranty only covers repairs carried out at our factory. 

Should the instrument have been incorporated into other equipment that requires 

our engineers to perform the repair on site, a charge will be made for the engineer's 

time to and from the site, plus any expenses incurred. 

 

The aforementioned provisions do not extend the original warranty period of any product 

that has been either repaired or replaced by R.D.P. Electronics. 

 

THIS WARRANTY MAY BE NULL AND VOID SHOULD 

THE CUSTOMER FAIL TO MEET OUR TERMS OF PAYMENT. 

 

  


